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Engineering drawing                                                                                      بم.م تمار ميثم عبدالوها 

 

AutoCAD 
 1. مقدمة عن البرنامج 

 الامريكية   الشركة  اصدرته  الابعاد   وثلاثية   ثنائية  لتصميمات  الحاسب  باستخدام  تصميم  برنامج  هو  AutoCAD  اوتوكاد

 اوتودسك  AUTODESK بمساعدة   التصمیم   ني�ت  التي  CAD  منتج  اسم   تحت  1980.  عام   منه  نسخة  اول  صدرت

.COMPUTER-AIDED DESIGN  الحاسب 

  هندسة المدنية، العمارة، الهندسة الميكانيكية، والتصميم الداخلي، والكهربائية، يستخدم في اي من مجالات التصميم 

 .الحقيقة في تكون كما   ومشاهدتها  المشاريع  تصاميم  كافة  لانشاء  يستخدم 

 
 حاليا    البرنامج   يستخدمها  التي  الجديدة  الواجهة   وهي   Annotation  &  Drafting  وهي  للبرنامج   الرئيسية   الواجهة 
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 باستخدام  ▼  الزر  على  الضغط طريق   عن   وهي  Classic  AutoCAD  يدعى  والذي القديم الشكل الى الواجهة  تغير  يمكن  حيث 

AutoCAD Classic  الماوس واختيار 

 
 
 
 
 
 
 
 
 

 
 :كالاتي  الواجهة شكل   يكون   سوف   Classic  AutoCAD  اختيار بعد 

 

 Bar  Menu  المندلسة   القوائم  شريط  باظهار  ونقوم  Annotation  &  Drafting  وهي  للاوتوكاد  الجديدة   الواجهة   الى  الرجوع 

 السريع   النفاذ   الشريط  في      الزر  على  الضغط  طريق  عن  Quick Access bad واختيار

bar Menu show  اوتوكاد  اوامر  جميع   على  يحتوي  الشريط  هذا  ان  حيث. 
 

 

  

Menu bar 
   

Draw toolbad    

Modify toolbar 
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 الاوتوكاد  في   الاوامر  2  1.

  :رئيسيةللحصول على امر في اوتوكاد لدينا ثلاثة طريق  

 كتابة الاسم الصريح للامر من لوحة المفاتيح   (1)

 (L)  او  Line  الامر   :مثال  )الاسم   هذا   اختصار (  او

 .الخط  لرسم  (Spacebar)  او   (ENTER)  المفتاح   على  الضغط  ثم

الحرف    نفس   لها  التي   الاوامر  جميع   يظهر   سوف   للامر   الاول  الحرف   كتابة  حالة  في  انه   حيث   الاوتوكاد  تطوير  تم

 .الامر   تذكر   على  تساعد  حيث  Complete  Autoبـ    الطريقة  هذه  وتسمى  .بسهولة  الامر   تختار   وتستطيع

 

 
 Bar  Menu  الرئيسية   القائمة   من  الامر  استخراج   (2)

 Line  ➔  Draw مثال   الامر   هذا   لها   يتبع  التي
 
 
 

 
  الادوات  ��ذا الامر على شر �یمثل   �الزر الذ  ��ض   (3)

 .المناسب

 
 

 
  الطريقة اما  .شيوعا    الاكثر الاوامر  وخاصة  المختصرات مع   التعامل عند  وخاصة الطرق  اسرع الاولى الطريقة   تعتبر

 .  ICON  ايقونة  لها  ليس   التي  الاوامر   وخاصتا    الاوامر   جميع  الى   للوصول  تستخدم  الثانية
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 النقطة   تعيين  طرق   3  1.

 .الرسم  شاشة   على  النقاط  مواقع  لتعيين  طرق   خمسة   توجد

 الذي   المكان  في  الرسم  شاشة   على  )الايسر   الزر(  بالفارة  النقر  طريقة   method  :Interactive  المباشرة  الطريقة   1.

 .دقيقة  غير   طريقة  وهي  فيه  النقطة  تعيين  نريد

 :الى  وتقسم  Coordinate  Absolute  المطلقة   الاحداثيات   2.

 .والنهاية   البداية   لنقطة   وتصلح   coordinate  rectangular  Absolute   المطلقة   الديكارتية   الاحداثيات  )أ (

 .الاصل   نقطة  الى  نسبة  النقطة  لتحديدة  Y  و  X  قيمة   ادخال  ,y)  (:x  الطريقة

coordinate  polar  Absolute   (ب ) المطلقة   القطبية  الاحداثيات الطريقة  .والنهاية   البداية   لنقطة   وتصلح 

.(:L<)  الطول   يعطي  حيث  L  الزاوية   ثم     الاصل  نقطة  الى   نسبة  النقطة  لتحديد. 

 :الى  وتقسم   Coordinate  Relative  النسبية   الاحداثيات  3.

 نقطة   تلي   التي   للنقاط  فقط  تصلح    coordinate  rectangular  Relative   النسبية   الديكارتية   الاحداثيات   )أ (

 .نقطة   اخر   الى  نسبة  النقطة  لتحديدة  Y  و  X  قيمة  ثم  @  ادخال  ,y)  (:@x  الطريقة  .سابقة

coordinate  polar  Relative   (ب ) النسبية   القطبية   الاحداثيات .سابقة   نقطة   تلي  التي  للنقاط  وتصلح 

 .نقطة  اخر   الى  نسبة  النقطة  لتحديد    الزاوية  ثم  L  الطول  يعطي  حيث  (L<@:).  الطريقة

 عن   سابقة   نقطة   تلي  التي  للنقاط  تصلح   technique  entry  Distance  :Direct  مباشرة    الطول  ادخال   طريقة   4.

 .مباشرة    المسافة   تدخل  ثم  ومن  المطلوب   بالاتجاه   الفارة   مؤشر   تحريك  طريقة 

 -  خط   نهاية(  للعناصر   مميزة  نقاط  اعتماد  يتم  حيث  snap  Object  :Using   للعناصر  المميزة  النقاط  طريقة  5.

     .ننفذه  الذي  للامر  المطلوبة  النقاط   تعيين  في   )الخ   ...  دائرة  مركز  -  خط  تعامد  -  خطين  تقاطع  -  خط  وسط    

 
 

 الرسم  ورقة  موصفات

 Drawing1.dwg   بالاسم  العنوان  شريط   في   يظهر  الملف  اسم   ان  اولا    لاحظ  الجديد  الرسم  ملف   مع   العمل  تبدا   عندما 

 ملف   بها  ننشأ  مرة  كل   في  اليا    يزداد   الرقم  هذا   ان  اذ  العمل  تسلسل   على  اعتمادا    3  او  2  او  1  العدد  يكون  ان  يمكن(

 جديد   ملف   لفتح  ).جديد
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 التالية   النافذة  تظهر   اعلاه  الخمسة   الخيارات  احدى   تنفيذ  عند 

 
  (in)  البوصة   بالوحدات  للرسم  (1)  الخيار

  (mm) للرسم بالوحدات المليليتر  (2)الخيار 

 Openثم اضغط 

 
 :ملاحظة 

 الامر  باستخدام   الرسم  واحدت  تغيير  يمكن

Units  لاحقا    يشرح   سوف  الذي 

 
 
 
 
 
 

 
 UNITS  Drawing   الرسم   وحدات  تعيين   (1)

 باحدى   ينفذ  والذي   Units      الامر   خلال  من  القياس   وحدات   من  مختلفة  انواع  مع  التعامل  امكانية  البرنامج  يوفر 

 :الطريقتين
 

 Command:  Menu bar 

Units  Format ➔ Units 

 :التالية  النافذة  تظهر   سوف  الخيارين  كلا  في
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متمثلة بعدد الحقول بعد الفاصلة العشرية للقياسات الخطية  Precisionوحدات الرسم و " درجة الدقة   typeيمكن تحديد نوع 
( لرسم عنصر ذات دقة رقمين بعد  0.00ثم اختر ( )  Precisionاضغط السهم في الحفل   lengthوالزاوية. مثلا تحت عنوان  

اضبط الاعدادات حسب ما يتطلبه عملك   Angleالفارزة. يمكن ايضا السيطرة على نوع وردجة دقة قياسات الزاوية تحت عنوان  
 لاغلاق مربع الحوار.   OKوبعد الانهاء انقر على موافق  

 

 
 LIMITS  Drawing   الرسم   لوحة  حدود   تعيين  (2)

 غرفة  ترسم  ان  يمكن  المثال  سبيل  فلعى  رسم،   وحدة   نسميها   افتراضية  واحدات  نستخدم  فاننا   الاوتوكاد  في   نرسم  عندما 

 على  واحدا    مترا    تعادل   الرسم   لوحة   على   المرسومة  الوحدة  تكون   وعندها   رسم   وحدة  5  ×  4  بــــــــ  م   5  ×  4  ابعادها 

 الرسم  لوحة  على  المرسومة  الوحدة  تكون  وعندها   رسم   وحدة  500  ×  400   بـــــــ  الغرفة  نفس  ترسم   ان  ويمكن  الارض

ما   ولكن  الرغبة   حسب   والواقع  الرسم  بين  النسبة   تحديد  يمكننا   الاساس  هذا   وعلى   .الارض  على  واحدا    سنتيمترا    تعادل

الحالة    في  كما  جدا    كبيرا    او  الاولى  الحالة  في  كما  الشاشة  على  جدا    صغيرا  يظهر  الاحيان  بعض  في  الرسم  ان  يحدث

بطول    تقاس   لا  العناصر   اطوال  ان  ملاحظة  مع   للرسم   المطلوبة  المساحة  مع  الشاشة  ملائمة  من  بد  لا  ولذلك  الثانية

 :التالية  الخطوات  نتبع  الرسم  مساحة  تحديد  ولبدأ  .بها  رسمت  التي  بالقيم  بل  الشاشة  في  ظهورها

 

 
 :التالية  الرسالة  تظهر   سوف  الخيارين  كلا  في

Specify lower left corner or [ON/OFF] <0.0000,0.0000>:  

  الخيار الفتراضي هو(يطلب تحديد الزاوية السفلى اليسارية بالاحداثيات  تغيرها   لا  حاول  <0.0000,0.0000>)

 :سوف تظهر العبارة التالية   Enterبالضغط على 

Specify upper right corner <12.0000,9.0000>: 

 .الرسم  لوحة  حدود  هي  لتكون  بادخالها  ترغب  التي  الاحداثيات  تكتب  وهنا  اليمنية  العليا  الزاوية  تحديد  تطلب  والتي

 حدود  خارج   تعطى  احداثيات  اي   فان  (ON)  نشطا    كان  فاذا  "الحدود  تدقيق"  حالة  على  يسيطر   [ON/OFF]  الخياران

  .لاتنشطها  ان ويفضل  ،limits  **Outside :التالية  الرسالة  ويعرض   يرسمها   لن البرنامج فان الورقة 

 :واليك هذا الجدول في قياسات بعض ورق الرسم

 Command:  Menu bar 

Limits  Format ➔ Drawing limits 

 

ISO A4 210 × 297 mm 

ISO A3 297 × 420 mm 

ISO A2 420 × 594 mm 

ISO A1 594 × 841 mm 

ISO A0 841 × 1189 mm 
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 والتعديل   الرسم   ادوات

Draw and Modify objects 

 من   بشي  الاوامر   هذه  سنتناول   لذلك  الاوتوكاد  في   الاوامر  مجموعات  اهم  من  والتعديل  الرسم  اوامر  مجموعتي   تعد

 .التفصيل 

 :  Line  خط  رسم   امر 

 :التالية  الثلاث  الطرق  باحدى  الامر  هذا   على   الحصول  يتم 

1.  Ribbon: Home tab ➔ Draw panel ➔Line 

2.  Menu: Draw ➔ Line 

3.  Command: L  or Space bar 

  Home  . (2 الرئيسية   البوابة   في  Drawالرسم    لوحة   في      الامر   لهذا   الممثلة   الايقونة  على  بالضغط   او  1)

 Line ➔  Drawالريئسية    القوائم اوامر  باستخدام

. Enter or Spacebar  ثم L  او  الحرف Enter  ثم Line  3) او  بكتابة 

 
 point:  first  Specify  Line  الاوامر   موجة  يظهر   حيث   البداية  نقطة  تحديد  البرنامج  يطلب  الامر   اعطاء  عند

 

  عناصر   من  مميزة  نقاط  انتقاء  للماوس،  الايسر  بالزر  نقر   الاحداثيات،(  سابقا    المذكورة الطرق باحدى البداية  نقطة نحدد

 )مرسومة سابقا  

 .سابقا    المذكورة   الطرق  باحدى  تحديدها   ويتم  or  point  next  Specify  [Undo]  التالية   نقطة   البرنامج   يطلب

 Enter  نضغط  الانتهاء   وعند  )مستمر   امر   Line  الامر   يعتبر (  المستقيمة  الخطوط  لرسم  النقاط  يطلب  البرنامج  ويستمر 

 Enter. نختار  ثم  الايمن  الفارة   زر  النقر  او  SpaceBar  او  المفاتيح   لوحة   من

 نقطة  اخر   عن  بالتراجع  لنا  يتيح  الخيار   وهذا  [Undo]   الاوامر   موجة  في  قوسين  بين  يظهر   الاولى  النقطة  تحديد  عند

 واحدة   نقطة  اخر   الغاؤ  فيتم  line  الامر  فصل  قبل   enter  ثم  u  وهو  الكبير   الحرف   نكتب  اليه  نصل  ولكي  تحديدها  تم

Enter   ثم بالكامل   الخط  الغاء  فيتم u وكتابة   الامر   فصل   عند  اما  .العملية  كررنا  كلما  الاخرى  تلو

 .المفاتيح   لوحة  من   z  +  Ctrl  استخدام  او  )السريع  النفاذ  شريط     الزر  استخدام   يمكن(

F8  مساعدات  شريط  في    الزر  او Ortho  التعامد   مسطرة   تفعيل  عند مفتاح   على  بالضغط 

 اضغط   ثم  المحدد  الطول  كتابة  ثم  المطلوب  الخط  لاتجاء  افقي  او  شاقولي  اتجاه  اعطاء  يمكن  Aids  Drawing  لرسم

Enter  المحدد   بالطول  المحدد  الاتجاء  حسب  افقي  او  شاقولي  خط  رسم  فيتم. 
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ویعنب   Close  عدة خطوط ممتابعة بامر واحد نلاحظ على موجه الاوامر ظهور امر مرافق اخر وهوعند رسم  
 .اغلاق مجموعة الخطوط بالعودة الى النقطة الاولى 

 ادناه   الشكل  ارسم  :مثال
 
 

 
 الاصل   نقطة

Origen point 

 

 
 :التالية  الرسالة  فتظهر  Line  الامر   نختار

Command: _line Specify first point: 10,10  

 :التالية الرسالة فتظهر   Enter  نضغط  ثم  10,10  ولتكن   الاولى  النقطة  احداثيات تطلب   والتي 

Specify next point or [Undo]: 150,10  

 :التالية الرسالة فتظهر  Enter  نضغط  ثم  150,10  ولتكن  التالية النقطة  احداثيات   تطلب  والتي 

Specify next point or [Undo]: 150,60  

 :التالية الرسالة فتظهر  Enter  نضغط  ثم  150,60  ولتكن  التالية النقطة  احداثيات   تطلب  والتي 

Specify next point or [Close/Undo]: 50,60  

 :التالية الرسالة  فتظهر  Enter  نضغط  ثم   50,60  ولتكن   التالية  النقطة  احداثيات  تطلب  والتي 

Specify next point or [Close/Undo]: 10,10  

 امر  ولانها  التالية،  النقطة  بطلب  يستمر حيث   Enter  نضغط ثم  10,10   ولتكن   التالية النقطة  احداثيات  تطلب والتي 

.Esc او Spacebar او Enter نضغط Line 

 ادناة   الشكل  ارسم  :مثال
 
 

 
 :التالية  الخطوات  نتبع

  Enterثم   10,10ثم ندخل احدثيات نقطة البداية وهي  Lineننفذ الامر   1.

 Enterثم    0>130@ نرسم الخط المستقيم الاول وذلك بكتابة  2.

  Enter .4  ثم  60>50@  بكتابة  وذلك  الثاني  المستقيم  خط  نرسم  3.

  نرسم  Enter  .5ثم   45>100@ بكتابة  وذلك  الثالث المستقيم خط نرسم

 Enter  ثم  @  -  0>100  بكتابة  وذلك  الرابع  المستقيم  خط

 Enter  ثم  130->157.21@  بكتابة  وذلك  الثاني   المستقيم  خط  نرسم   6.

 :ملاحظة

 Escape  زر   على  نضغط  الامر   هذا  فصل  واردنا   امر   تنفيذ  حالة  في  1.

حيث يظهر اسم الأمر في .    Space barاو   Enterفي حالة اردنا تكرار اخر امر تم استخدامه نضغط زر   2.
Command bar  موجة 

( الاستعراض جميع الأوامر المنفذ على    Command windowيفتح نافذة الأوامر   F2في حالة الضغط على زر    3.



9 

Engineering drawing                                                                                     م.م تمار ميثم عبدالوهاب 

 

: 

 .الضغط عليه مره ثانية يعود الى حالة الطبيعية.

 
 :  )مسح (  Erase  التعديل  امر

 

 
 :المرسومة  العناصر  بمحي   الامر  هذا  يقوم

 Command:  Menu bar  Ribbon 

E  or Spacebar Modify ➔ Erase Home tab ➔ Modify panel ➔Erase 

 
عند اختيار الامر باحدى الطرق السابقة يسألنا  

 البرنامج عن العناصر التي نود ان نمحوها 

 ).عناصر  اختر(  objects  select  بالعبارة 

 :ملاحظة

 .وهي تختار كل العناصر التي تحتويها او تقطعها :نافذة التقاطع

 .وهي تختار كل العناصر التي بداخلها فقط  :نافذة الاحتواء

 التالية   بالطرق  العناصر  اختيار  ويتم   صغير  مربع  الى  المؤشر  ويتحول   •

 .العنصر  على   المباشر   بالنقر  1.

ويكون    .عناصر  من  معها   يتقاطع  ما   كل  تختار  النافذة  هذه  )اعلى   او  اسفل(  اليسار   الى  اليمين   من   تقاطع   بنافذة  2.

 .الشكل مستطيلة  وهي .منقطة خطوط  وذات  عموما   اخضر  شكلها 

 .ضمنها   كامل   بشكل  الواقعة  العناصر   الا  تختار   لا  النافذة  هذه  )اعلى  او  اسفل(  اليمين  الى  اليسار   من  احتواء  بنافذة  3.

 .الشكل  مستطيلة  وهي  .صلبة  وخطوط  ازرق  لون  ذات

 الاحتواء   نافذة  تفعل (  اليسار   الى  اليمين  او  اليمين  الى  اليسار   من  احتواء  بنافذة  يقوم  Enter:  ثم  W  الحرف   كتابة4.

(W: window) .( فقط 

 ).فقط  التقاطع   نافذة  تفعل  اي (  العكس   او  اليمين  الى  اليسار   من   التقاطع  بنافذة   يقوم   Enter:  ثم   C  الحرف  كتابة   5.

.(C: crossing) 

 .مغلق  مضلع  ضمن  بالكامل  تقع  التي  العناصر   جميع  لتحديد   الخيار   هذا   يستخدم   WP:  الحرفان  6.

(WP: Window Polygon) 

 هذا   يقطعها   او  مغلق  مضلع  ضمن  بالكامل  تقع  التي  العناصر   جميع   لتحديد   الخيار  هذا   يستخدم   CP:  الحرفان  7.

(CP: Crossing Polygon) . المضلع 

 :Last)  (L  .انشاؤه   تم   عنصر   اخر   لتحديد  L:  الحرف   8.

 :Previous)  (P  .سابقا    اختيارها  تم   التي  العناصر  جميع  لاختيار   يستخدم  P:  الحرف   9.

  Fence) (F:  .11  .يستخدم لتحديد جميع العناصر التي يقطعها خط منكسر  F:الحرف  10.

.الرسم  لوحة على  العناصر جميع  اختيار يتم   فانه   ALL:الكلمة 

   
Erase اختيار 
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حيث تستطيع   Remove objectsيقوم بعكس خيار المسح حيث يتحول مشؤشر الأوامر الى  R: الحرف  12.

استخدام الأوامر اعلاه لاختيار العناصر التي سبق وان قمنا بالختيارها لكي نمسحها، وللرجوع الى الأمر  

Select objects  تكتب الحرفA  ... ونستمر بامر الاختيار لكي نمسح العناصر 

 
 

 
 يظهر  سوف  Enter  ثم  r  الحرف  طباعة

 
 
 

 
 يظهر  سوف  Enter  ثم  a  الحرف  طباعة

 

 
 :ملاحظة

 شكل   على  فتظهر   العناصر   هذه  تحديد  يتم   حيث  Erase   الامر   اختيار   قبل  مسحها   المراد   العناصر   اختيار   يمكن   •

 

A  +  Ctrl  جميع   تحديد  فيتم 

 .العناصر   مسح  يتم   المفاتيح  لوحة  من  Delete  المفتاح  على   بالضغط  تم   منقط  خط

  على المفتاحين  بالضغط على شاشة الرسم   يمكن اختيار جميع العناصر الظاهرة  •

 .يتم مسحها  Deleteالعناصر وبالضغط على زر  

  على   نضغط  ثم   مستمر   بشكل   Shift   زر   على  نضغط  اختيارها   تم   ان  بعد   المحي  من  العناصر  بعض  استثناء  عند    •

 .العنصر المحدد فيتم الغاء تحديده

 

 Z  +  .Ctrl  او   :  u  Command  بكتابة  نقوم  المسح  عملية  من  العناصر  استرجاع  عند   •

 الاوامر  شريط  في   يكتب  :-  oops  الامر   •

 من   العديد  ممارسة   بعد  حتى  ينفذ  انه   وميزاته  الرسم  لوحة  الى  على   مسح  تم  عنصر  اخر   باعادة   oops  الامر   يستخدم

 .لوحة  نفس   على  الاوامر 

 


